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Luminosity Masks 
Luminosity Masks, also known as Luminance Masks, are a 

special type of layer mask. They are created by making selections 
based on luminosity values in an image and then converting those 
(usually complex) selections in to layer mask. They enable you to 
make adjustments a limited range of tones without altering the 
other tones in an image. If you are not confident that you 
understand what layers and layer masks are, I suggest that you 
refer to my tutorial on “Layers, Masks and Channels” which is 
downloadable from the Belmont 16s Photography Club website. I 
will quickly revise a few of the key points from those notes. 

The basic idea of a Layer Mask is that it enables you to 
“mask” or “hide” parts of a layer and reveal other parts. On a layer 
mask you can have shades of grey but not colours: 

On an image layer, the parts of the layer mask that are 
WHITE allow the corresponding part of the image to be 
visible. On an adjustment layer, the parts of the mask that 
are white allow the adjustment to be applied to the 
corresponding part of the image.  

On an image layer, the parts of the layer mask that are 
BLACK completely hide the corresponding part of the image 
and reveal the image in the layers below.  On an adjustment 
layer, the parts of the mask that are black prevent the 
adjustment from having any effect on the corresponding 
part of the image. 

The parts of the layer mask that are shades of GREY reduce 
the effect of the mask on that part of the image. The extent 
of the effect will depend on how dark or light the shades of 
grey are. If the mask is on an image layer, the parts of the 
image that correspond with the grey parts of the mask will 
be made partially transparent. If the mask is on an 
adjustment layer the effect of the adjustment will be 
partially reduced on the parts of the image that correspond 
to grey on the mask. 

To illustrate this concept, consider a Photoshop document that 
has two layers, a base layer of a solid colour (green) and above that 
an image layer. Without a layer mask, what you would see on the 
screen is just the image. However, if I add a layer mask that is 
partially black, partially white and partial mid-grey this is what you 
would see in the Layers palette: 
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The image would then look like this: 

The part of the image that corresponds to the black part of the 
mask has become transparent. The part of the image that 
corresponds to the grey area of the mask has become partially 
transparent. 

In Photoshop, when you create any type of adjustment layer 
(Curves, Levels, etc) a white layer mask is automatically created on 
that adjustment layer. This is in preparation for you to paint (in 
black or a shade of grey) on that layer mask to reduce the effect of 
the adjustment on some parts of the layer. 
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To illustrate this point, I opened an image and added a Hue/
Saturation adjustment layer. This automatically placed a white layer 
mask on that adjustment layer and I painted part of the mask black 
and part of the mask mid-grey. The layers palette shows this: 

The effect of this on the image is shown here: 

Where the mask is black, we can see the image without the 
effect of the Hue/Saturation adjustment. Where the mask is white 
we see the full effect of the adjustment. Where the mask is grey we 
see the partial effect of the adjustment. 
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Creating Layer Masks 
The simplest way to restrict an adjustment to only part of a 

layer is to use a brush to paint in black over the parts of the layer 
mask where you do NOT want the adjustment to be applied. For 
example, with this image I might want to increase the contrast in 
the foreground and close hills but not change the appearance of the 
sky or the ‘blue’ 
hills. I can do this 
by adding a 
suitable Curves 
adjustment layer 
(to give the desired 
contrast) and then 
painting in black 
on the area of the 
layer mask that 
corresponds with 
the sky and the 
blue hills. 
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This gives the result I wanted: 

Unless the Layer Mask is very simple (as in the example above) 
it may be difficult and/or time-consuming to create the mask you 
want. In those situations you need to be able to create a complex 
SELECTION and convert that selection into a LAYER MASK. There 
are many different ways to create selections. You could try to use 
one the basic selection tools: 

Alternatively. you could also try to use one of the quick 
selection tools: 
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You might also try selecting a colour range or the in-focus area 
of the image: 

Once you have made a selection (by any means) you can turn 
it into a Layer Mask by clicking on the Layer Mask icon at the 
bottom of the Layers palette. All the selection methods above tend to 
work best when the area or object that you want to select is fairly 
distinct from the area that you do not want to select. For example 
with the image below you could get a reasonable selection of the 
bird in at least four different ways: 
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Once the basic mask is created from and of these selections 
you could refine the mask with careful painting. The real challenge 
comes when you want to make adjustments to an area of the image 
that is not easily separated from the background. Consider this 
image for example: 
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If I wanted to make different adjustments to the bird and to its 
surroundings it would be very difficult to make a suitable selection 
with any of the previous methods, particularly for areas such as 
where the grass is in front of the bird. Of course, for this particular 
image I could try a Photoshop adjustment such as Shadows/
Highlights that does not require me to make any selection. However,  
the results may not be satisfactory because of the limited control 
that is available with this adjustment. It would be useful to be able 
to make a selection of the bird (mainly very dark) and a separate 
selection of the surroundings (mainly much lighter) in a way that 
would enable me to make more controlled adjustments to each area.  

This degree of control over adjustments can be achieved with 
luminosity masks. I will illustrate this general technique and then 
explain how luminosity masks can be created. 

A SIMPLE EXAMPLE 
The image on the previous page is one that would benefit from 

separate adjustments to the light and dark areas.  Toning down the 
highlights would make the grass less distracting (particularly in the 
top left of the image). A slight boost to the tone and contrast in the 
black feathers would make the bird stand out more from its 
surroundings. Because the tonal values on the two areas to be 
adjusted (grass and bird) are so different we could try creating a 
mask from just the tones below mid-grey (less than 128 on the 
0-255 scale) and another mask from just the tones above mid-grey 
the masks would look like this: 

A mask created from the light tones. 

(c)  2017  Roy Killen Luminosity Masks, Page �9



A mask created from the dark tones. 

The first thing to notice about the masks is that the light areas 
correspond to pixels that will be selected. The second thing to notice 
is that they contain a range of grey tones that give smooth 
transitions between the pixels that are fully selected (white), those 
that are partially selected (various shades of grey) and those that 
are not selected (black). The third thing to notice is that the masks 
allow you to see what pixels are being selected before any 
adjustment is made. Later in the article I explain how to create 
these masks and how to refine them if necessary. 

For this example, I will apply the masks to two separate 
Curves adjustment layers. 

The relative positions of the two Curves adjustment layers 
(light adjustment above or below the dark adjustment) may make a 
slight difference to the overall appearance of the image because 
both these masks contain a lot of grey (rather than pure black or 
white) tones. You can try swapping the positions of these two layers 
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but for many images the difference will not be significant. The 
adjustments I applied were: 

Notice that the Curves adjustment applied to the dark pixels 
has a slight ’S’ shape which will increase the overall contrast in the 
dark areas, and that the tones towards the middle of the tonal 
range have been lightened a little. This adjustment will have 
virtually no effect on the lighter tones in the image because the 
mask has hidden those tones. 

The Curves adjustment for the light tones will effect all the 
pixels that are fully or partially selected by that mask and the 
changes in their tonal values will be more significant than the 
changes to the dark tones (because the curve has been dragged 
further away form its neutral position). Notice that this Curve is 
now quite steep and this will increase contrast in the lighter areas 
of the image. The overall result is: 
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GENERATING LUMINOSITY MASKS 
There are many ways to generate luminosity masks. How you 

choose to do it will depend on how familiar you are with Layers, 
Masks and Channels in Photoshop and how much ‘manual’ control 
you want over the process of creating and using the masks. I will 
start with a brief introduction to generating luminosity masks from 
the R, G and B channels and then describe some methods that use 
more ‘automated’ techniques. 

I would like to remind you again that if you are not really 
confident that you understand Layers, Masks and Channels please 
refer to my tutorial on “Layers, Masks and Channels” which is 
downloadable from the Belmont 16s Photography Club website. 
That tutorial has been updated since I first put it there in 2016. 

A typical situation in which luminosity masks can be useful 
for selectively editing an image will be illustrated with the following 
sunset image in which I want to restore some of the colour to the 
sky without significantly changing the foreground. As you can see, 
selecting the sky by any of the methods described in the early part 
of this tutorial would be quite difficult. 

If we open this image in Photoshop and look at the Channels 
palette we will see this: 
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The small icons indicate that in each channel (red, green and 
blue) the sky is much brighter than the foreground so potentially 
any one of these channels could be used to create a selection of the 
sky. If we click on each channel one at a time Photoshop will display 
the individual channel luminance information rather than the 
composite RGB image. This will enable us to see that (for this 
particular image) the blue channel gives suitable separation 
between the sky and the foreground. The blue channel luminance 
looks like this:  

Note that although the sky area is not very bright the 
foreground is very dark. (I will explain later how to increase the 
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contrast between these two areas.) To turn the Blue channel into a 
selection and then into a Layer Mask, follow these steps: 

‣ In the Channels palette, make sure that all the channels (red, 
green, blue) and the RGB channel are visible. 

‣ Hold down the Control key (Windows) or the Command key 
(Mac) and click on the Blue channel. This will create s 
selection from the Blue channel (and put ‘marching ants’ on 
the image). 

‣ Go to the Layers palette and duplicate the background layer. 
A simple way to do this is to select the background layer, hold 
down the Control key (Windows) or Command key (Mac) and 
press the letter “J” on the keyboard. 

‣ Select the duplicate layer (just click on it) and then at the 
bottom of the Layers palette, click on the “Create Mask” icon 
(third icon from the left). This will create a Layer Mask on the 
duplicate layer and the mask will be exactly the same as the 
luminance information in the Blue channel. In other words, 
we have created a Luminosity Mask and the Layers palette 
will look like this: 

At this stage, the appearance of the image will not have 
changed because anything the layer mask is ‘hiding’ on the 
duplicate layer will simply be revealed from the layer below.  

To intensify the colour in the sky, change the Blending Mode 
of the duplicate layer from “Normal” to “Multiply”. This Blending 
Mode change will effect only those areas of the image that 
correspond with the lighter areas of the Layer Mask. The image now 
looks like this: 
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Because the lightest areas of the layer mask are shades of grey 
(rather than pure white) the effect of the blend mode change will be 
subtle. If it was stronger than you wanted, you could simply reduce 
the opacity of the duplicate layer. 

If you want to make the effect of the blending mode change 
stronger you could: 

‣ Alt-click on the layer mask (in the 
Layers palette) to open it.  

‣ Select Image>Adjustments>Levels 
and make an adjustment that would 
lighten the light areas of the mask 
and darken the dark areas. Perhaps 
an adjustment like this: 

‣ Then Alt-click on the layer mask again to close it.  

Because of the adjustments made to the mask, the effect of the 
blending mode change will be increased in areas of the image that 
correspond to the lighter areas of the mask and decreased in areas 
of the image that correspond to the darker areas of the mask.  

(c)  2017  Roy Killen Luminosity Masks, Page �15



The image would then look like this: 

Again, you have the option of reducing the opacity of the 
duplicate layer to reduce the effect of the blending mode change if it 
is too strong. You also have the option of experimenting with 
different blending modes - perhaps Linear Burn for this image. 

 The previous example is a simple way of creating and 
modifying luminosity masks using one of the colour channels (R, G 
or B) as the starting point for the selection of tonal values from 
which to generate the mask. This can be a powerful and useful 
technique. However, if you want more flexibility in your choice of 
starting point (rather than just the R, G and B channels) and you 
want more flexibility in what you can do with the luminosity masks 
(rather than just apply them to a duplicate of your image) then you 
might want to explore the use of various “Action Panels” that are 
available for creating Luminosity Masks. 

An “Action” in Photoshop is simply a series of steps that have 
been recorded so that they can be performed again “at the click of a 
button”. There are numerous ‘panels’ available that can be installed 
in Photoshop to provide access to pre-recorded actions that 
generate Luminosity Masks in various ways. 
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In the Appendix of these notes I have listed some websites and 
videos  that might help you to decide which luminosity mask action 
panel will suit your needs. Three of the panels that I use are: TK 
Panel V5; Lumenzia v13.0.2; and Raya Pro 2.0. In the Appendix 
there is a link to a video that compares these panels with several 
others. 

My recommendation for those just starting to explore 
Luminosity Masks is to download the FREE “TK Actions Basic 
Panel” from Tony Kuyper’s website - see the Appendix for download 
details. This panel will allow you to experiment with the basic uses 
of luminosity masks and help you to decide which more 
sophisticated approach might best suit your needs. 

When you download the TK Actions Basic Panel you will 
receive instructions 
for installing it in 
Photoshop - just a 
couple of simple 
steps of copying 
files and then it 
will be available 
from the 
Window>Extensions menu. When you 
select Window>Extensions from the 
menu, you get a drop-down list of all 
the “extensions” that have been 
installed in Photoshop - just click on 
“Basic” to open the TK Basic panel. It 
looks like this: 

The top section of this panel 
is used for generating luminosity 
masks and putting them on Curves 
adjustment layers; the middle section 
is for generating luminosity masks 
and putting them on Levels 
adjustment layers; and the bottom 
section is for generating luminosity 
masks that are placed in the 
Channels palette (from where you can 
use them to create selections and 
then masks to apply to any layer. If 
you hover the mouse over any of the 
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buttons (L5 in this example) the window at the bottom of the panel 
gives a short description of what will happen if you click the button. 
In this example it will create a Levels adjustment layer above your 
image layer and generate a layer mask based on “Lights-5” which is 
a selection of the pixels in the image that are lighter than about 200 
on the 0-255 luminosity scale. 

If you click on the “ALL” button in any of the rows it will 
generate multiple adjustment layers, each with a different 
luminosity mask - for example, five different Curves adjustment 
layers each with a different “Lights” luminosity mask. This can be a 
quick way to review all the masks and decide which mask will be 
most suitable for a particular image. You can easily delete the layers 
containing the masks you do not want to use. 

After you become familiar with this simple (and free) method of 
generating luminosity masks you will soon see how they can 
improve your image editing techniques. At that stage you may wish 
to explore more complex options that let you generate a greater 
variety of masks and apply them to a greater variety of adjustment 
layers (not just Levels and Curves layers).   

Of the more sophisticated luminosity action panels that I have 
tried (TK, Lumenzia and Raya) I generally prefer TK for its precision 
and flexibility but it does take a little more effort to master than 
either of the others. From version 5, the TK Panel panel actually 
installs as five separate panels, each one devoted to a separate 
group of tasks. One panel contains a great selection of very useful 
shortcuts for frequently used Photoshop functions (such as 
flattening layers and merging visible layers). There are numerous 
YouTube videos that explain how to use the TK panel. 

Lumenzia is slightly easier to master than TK, simply because 
it has fewer options and its operation is perhaps a little more 
intuitive. It is a very good panel for ‘intermediate’ level users. 

Raya Pro has been designed specially the assist with the task 
of blending images and the developer, Jimmy McIntyre, has 
produced lots of video tutorial to explain how this is done. It is not 
quite as flexible as TK or Lumenzia for some of the other 
applications of luminosity masks. 

EXPLORING THE TK RapidMask PANEL 
If you instal the TK Actions V5, a good starting point for 

understanding how to use it to create luminosity masks is the “TK 
RapidMask” panel which looks like this: 
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As with the free TK Basic panel, if you hover the mouse over 
any button you get a brief description at the bottom of the panel 
(marker “5”) to tell you what this button will do. 

To create a luminosity mask, start at the top of the panel 
(marker “1”) and select the information that you want the panel to 
use as the basis for the mask. Normally this will be “Composite” 
which will use the luminance information in the Red, Green and 
Blue channels to generate the mask. However, you could choose to 
use the luminance information in just one of the RGB channels or 
one of the Lab channels (if your image is in Lab colour mode). You 
could also use the Saturation levels in the image as a starting point 
for the mask; or one of the colours (red, green, blue, cyan, magenta 
or yellow); or a colour range that you select (CR). 

Once you select the information that the panel will use to 
generate the mask, you select a broad tonal range (marker “2”) or a 
tonal “zone” (marker “3”) for the mask. The +/- bottoms create a full 
set of tonal selections and place them in the Channels palette. The 
“pick” button lets you select a tonal range by clicking anywhere in 
the image. 

The buttons opposite marker “4” that are outlined in red give 
you various options for refining the mask. The buttons that are 
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outlined in yellow give you options for doing things with the mask - 
adding it to various types of adjustment layers, turning it into a 
selection, saving it as a channel, creating a pixel layer out of it, or 
applying the mask to the currently selected layer. The two buttons 
outlined in green let you swap between viewing the mask and 
viewing the image with the mask applied. 

This might all seem  little daunting at first, but once you have 
experimented with a few images you will soon see how easy it is to 
use this panel to generate and apply luminosity masks.   

TK Infinity Mask Panel 
Tony Kuyper, who developed the TK Actions Panel has recently 

released a new type of luminosity masking panel that he calls the 
“TK Infinity Mask Panel”. It enables you to generate an infinite 
number of masks rather than the fixed number of masks that you 
can generate with other panels. I find this approach particularly 
useful and quite intuitive to use. Is is also cheaper than most other 
panels. However, it will only work in the various versions of 
Photoshop CC (not CS6 or earlier). The Infinity Mask panel looks 
like this: 
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The buttons in section “1” allow you to select the information 
that will be used to generate the masks - the luminance information 
in the combined Red, Green and Blue channels; or the luminance 
information in just one of the R, G or B channels; or saturation 
information; or a colour that you pick in the image. Having made 
that initial choice you then select the “Darks-1” or the “Lights-1” to 
limit the tonal range for the initial mask.  

At this stage you will be viewing the mask on the screen and 
you can use the sliders in section “2” of the panel to modify the 
mask. You can extend or limit the tonal range, make the transitions 
from light to dark more or less distinct and reduce the overall 
intensity of the mask. 

Finally you select from section “3” where you want the mask to 
be applied.  The options in the bottom row of buttons let you apply 
the mask to a Curves or Levels or Hue/Saturation of Brightness/
Contrast layer. The Channel button lets you save the mask as a 
Channel. The Selection button turns the mask into a selection 
(“marching ants”). The Apply button will add the layer mask to 
whatever layer you have currently selected. The Pixel button will 
create an image layer from the mask. 

A SPECIAL APPLICATION FOR LUMINOSITY 
MASKS 

Most images can benefit from some sharpening before they are 
printed or before they are displayed on the web. One of the 
important aspects of sharpening is that it should produce a clear, 
crisp image that does not look over-sharpened. A sure sign of over-
sharpening is the appearance of ‘halos’ (thin bands of brightness in 
light areas that are adjacent to dark areas - such as in the sky at 
the horizon).  

If you are using basic sharpening techniques, such as 
Unsharp Mask in Photoshop, it can be difficult to avoid these halos. 
But luminosity masks can help. 

In the following example, I have deliberately over-sharpened 
an image to produce halos so that I can show how they can be 
removed with a simple luminosity mask generated with one of the 
Action Panels referred to earlier. 
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This is the unsharpened image and an enlargement of part of 
it. Before proceeding, I need to duplicate the image layer - that is 
where I will do the sharpening and applying the mask. 
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Here is the same section of the image with an excessive 
amount of sharpening applied: 

I have added the arrow to draw attention to one area in which 
the sharpening halos are very visible. 

To remove the halos I generated a “Lights” luminosity mask 
that looks like this: 

The halos are clearly visible in this mask, but since I want to 
hide the halos I need to invert the mask so that the halos are black 
on the mask. 
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The inverted mask looks like this and when it is applied to the 
sharpened image you can see that it hides the halos.  

The black areas of the inverted mask may also be hiding some 
of the other areas of the sharpening image that you do not want to 
hide. To solve this, you can paint (in white) on the mask to reveal 
those areas of the image. 
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Conclusion 
Once you have learned how to create luminosity masks there 

are many options for using them. The most common uses are for 
making controlled tonal adjustments and for blending images. 
However, they can help you refine your editing techniques in many 
other ways. For example, you can use them to reduce artefacts 
when sharpening images (but that’s for another tutorial). The fun is 
endless! 

Whatever technique you use to create luminosity masks they 
will generally have one very definite advantage over layer masks 
created in other ways - the mask will have very good tonal 
feathering (not abrupt changes from white to black). This allows 
your adjustments to blend smoothly with the original image and not 
have a ‘paper cut-out’ appearance. The result is likely to be a more 
natural looking final image. 

No matter what approach to editing that you take, the success 
of your final result will depend on careful planning. When you open 
an image to edit it, you should sit on your hands for a few minutes 
and not touch anything until you have done two things: 

1. Visualised the final result that you want. 

2. Plan the basic steps that will allow you to achieve that 
result. 

 These notes a just a brief introduction to luminosity masks. If 
you would like to ask questions about any of the information in 
these notes, or make suggestions for improving them please email 
me. 

Roy Killen 

Email: roykillen@mac.com 

23rd May, 2017. 
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APPENDIX - SOME LUMINOSITY MASK RESOURCES 

To download the FREE “TK Actions Basic Panel” go to http://
goodlight.us/panels-and-videos.html  

VIDEOS	ON	TK	ACTIONS	
h.ps://www.youtube.com/watch?v=dqFZTBa9UII	introducKon	
h.ps://www.youtube.com/watch?v=WykYFVcZ0zY	
h.ps://www.youtube.com/watch?v=v8n44PvcF-8	
h.ps://www.youtube.com/watch?v=ieWvAHdE2_w	TK	AcKons	V5	by	Tony	Kruper	

OTHER	VIDEOS	ON	LUMINOSITY	MASKS	
h.ps://www.youtube.com/watch?v=gz0yHXy0s-U	What	are	luminosity	masks?	

h.ps://www.youtube.com/watch?v=xWnqlYl8iH8&feature=em-subs_digest-vrecs		A	review	of	
five	different	luminosity	mask	panels.	

h.ps://www.youtube.com/watch?v=eewT6z92vBM		IntroducKon	to	InstaMask	

h.ps://www.youtube.com/watch?v=ga17QmP-TTY	General	info	on	blending	exposures	

h.ps://www.youtube.com/watch?v=FHw5QQW5fpo	Blending	exposures	

h.ps://www.youtube.com/watch?v=ImPUyujpfgY		ADP	Panel	

h.ps://www.youtube.com/watch?v=yWk8YaOKTQQ		Lumenzia	

h.ps://www.youtube.com/watch?v=t3N_gIP3H8Q		Tonal	balancing	
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